
 

What’s New in version 3.03 December 2011 

ProVal version 3.03 introduces multi-core computing for speed, easier navigation for sample 

lives, and over 50 additional features listed below. 

Speed 

 Multi-core computing.  Valuations, Core Projections and Gain/loss Analysis now run faster on 

multi-core computers (commercially available since 2005) by simultaneously running 

calculations on up to four local processors.  For more, see Multi-Core Computing on page 12. 

 

 Inherently faster.  In addition to some across-the-board speedups, you’ll find that Valuations, 

Core Projections, and Gain/loss Analysis that use lump sum components, determine optional 

form conversions based on interest and mortality, include a post-decrement death benefit for 

actives with the beneficiary determined at member death, or specify spouse age difference by 

table are faster.  Average speedup is around 10%.  In addition, accounting core projections are 

approximately 30% faster. 

Sample Lives 

 Easier navigation.  Sample life reports are now listed in a tree. Click on a report’s name on 
the left side to display the report (the ↑ and ↓ arrow keys can also be used to move between 

reports).  Many reports are grouped into folders.  To expand or collapse a folder, click on  or  
(or use the → and ← arrow keys).  Alternatively, right-click on the tree and choose “Expand All” 

or “Collapse All”. 
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Besides navigating among reports, you can easily: 

o  select an individual record to display (or <all>) and change the 

field used to identify records (RecID is the default), 

o  select benefits or decrement ages to display, and 

o   print or save one or more reports. 

 Sample lives now skip benefits for which the selected sample life records are not eligible, 

resulting in less clutter.  In extreme cases with hundreds (or thousands) of benefits, this runs 

faster and avoids potentially running out of memory.  

Gain/Loss Analysis 

 Interest rate assumption changes.  If you run gain/loss analysis with a different beginning 

of period and end of period interest rate, ProVal now automatically calculates the assumption 

change gain/loss.  Only changes in the valuation interest rate are measured; other explicit 

assumption changes still produce unreconciled amounts.  

 Implicit assumption change splits.  Implicit assumption changes are now separated into 

three buckets: (a) dynamic mortality, (b) interest rate, and (c) other.  An implicit assumption 

change is generated when merely changing the valuation date changes the assumption.  An 

implicit dynamic mortality assumption change occurs when using one of ProVal’s “dynamic” 

tables that change based on the valuation date.  An implicit interest rate assumption change 

occurs when an interest rate varies based on duration from the valuation date (e.g., spot rates, 

segment rates).  The “other” category is relatively rare, occurring in situations such as when 

pre- and post-decrement interest rates differ, a custom U.S. PIA operator is utilized with a 

salary override based on the valuation date, and mid-year changes in accrual rates are 

assumed as if effective on the valuation date (U.S. PPA funding assumptions only). 

 

U.S. Nondiscrimination Testing   

 Accrual rate statistics.  The U.S. Nondiscrimination Coverage and General Tests tool now has 

an option to output accrual rate statistics. These are useful for analyzing current test results, 

and also for design analysis and assessing future results.  To facilitate some of the statistics, 

the U.S. Nondiscrimination Accrual Rates tool now includes individual results for testing service 

at plan year end, testing age, and DC allocation during the measurement period.  
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 The U.S. Nondiscrimination General Tests tool has a new option to use the normal rate as a 

minimum for the most valuable rate.  This can occur, for example, for older participants (e.g., 

over age 70) due to interactions between standard normalization assumptions and plan 

actuarial equivalence. This option avoids an intermediate step to overwrite the individual results 

database using Define Field by Expression. 

Pension Plans 

 Eligibility for vested liabilities. In Valuation Assumptions > Liability Methods (or Current 

Liability topic if non-PPA U.S. funding), when vested liabilities are calculated, there is a new 

option to determine eligibility for vested benefits at the valuation date, rather than at the first 

decrement age.  This is useful if mid-year decrements are assumed. 

U.S. Qualified Pension Plans 

 Disability mortality by coded field.  In PPA valuation assumptions, disability mortality rates 

can now vary by coded database field.  This eliminates the need for a second run if assuming 

different disabled mortality for members who became disabled before and after 1995. 

 Deferred lump sum as optional form.  Deferred lump sums can now be set up as an 

optional payment form; this eliminates needing to set up a second benefit formula to value a 

deferred lump sum payment form.  (This option is available in all pension modes, but commonly 

used for U.S. Qualified Pension plans.) 

 In Valuation Assumptions > Regulatory Data > U.S. Maximum Benefits, there is a new option to 

apply the Plan’s benefit payment frequency and timing when calculating 415 limit actuarial 

reduction and increase factors. 

 The PBGC segment rates and the method used are now displayed in the PPA Development of 

PBGC Premium exhibit for Valuation Sets, Deterministic Forecasts, and Stochastic Trials. 

U.S. Multiemployer Plans 

 Multiple eligibility service definitions.  The Benefit Definition Eligibility screen now allows 

multiple definitions of service for eligibility.  (This option is available in all modes, but 

commonly used for multiemployer plans in U.S. Qualified Pension mode.) 



What’s New, ProVal version 3.03 - 4 - December 2011 

 

U.S. Public Pension Plans 

 Employee contributions and entry age normal.  A new option in Valuation Assumptions lets 

you calculate the employee contribution normal cost offset under Entry Age Normal as the 

expected contributions for the year. In other words, use the same normal cost offset for EAN as 

used for PUC and UC.  (This option is available in all pension modes, but commonly used for 

U.S. Public Pension plans.)  

 “Public Pension” mode has been renamed “U.S. Public Pension” to clarify the kinds of plans it is 

designed for. 

OPEB Plans 

 Joint life annuity to member. A new “Joint Life Annuity to Member” payment form pays an 

annuity to the member while both the member and spouse are alive. It is identical to the “Joint 

Life Annuity to Spouse” payment form, except that the gross and participant contribution 

formulas (including any table lookups) are based on the member’s age, sex, etc. rather than 

the spouse’s.  It can also be used to value payments to the retiree after death of the spouse 

(reversionary to member), by valuing a “Life Annuity to Member” payment form with positive 

benefit B and a “Joint Life Annuity to Member” payment form with negative benefit –B. 

 #VALYEAR. A new operator, #VALYEAR, returns the valuation year, projected in a forecast 

(e.g., 2018). This operator is available in all modes, but may facilitate the measurement of plan 

amendments in OPEB core projections. For example, in a core projection with an initial 

valuation date of 1/1/2012, the benefit formula pictured below will return “Claims – Contrib” for 

the first two projection years (2012 and 2013) and “(Claims - Contrib) #MIN Cap” for later 

projection years.  Caution: Although this will produce the right liabilities and reflect the 

amended plan beginning with the 2014 valuation, ProVal will not set up a prior service cost (or 

any special amortization) to reflect this amendment.  Rather, the change in liability will flow 

through to gain and loss. 
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 Sample life detail is now available for the #DECAGE, #DECPTS, #DECSVC, and #PMTAGE 

operators. 

 The calculations of expected future service to retirement and full eligibility (as well as active life 

expectancy) now consider whether a non-zero benefit is payable for each decrement age, 

rather than assuming that an employer benefit is provided simply because eligibility conditions 

have been met.  Consider a plan that only provides pre-Medicare coverage, but assumes some 

decrement ages at or beyond Medicare coverage age with a zero benefit. Total expected future 

service (TEFS) will now be decreased by excluding ages with zero benefits. This change will also 

affect average expected future service (AEFS), but could result in either an increase or 

decrease depending on the relative reduction in TEFS (numerator) vs. the number expected to 

receive benefits (denominator). This affects OPEB plans with zero benefits only; it has no 

impact on OPEB plans with non-zero benefits at all eligible ages. 

Canadian Registered Pension Plans 

 Letters of Credit. A new option has been added that allows letters of credit to be applied 

towards solvency deficiency payments; this is helpful for plans that have letters of credit and 

are operating under Alberta or British Columbia provincial law.  Previously letters of credit were 

always added to the solvency assets. 

 New options have been added that allow more flexibility in the application of actuarial and 

solvency gains to existing amortization bases, including a new option that allows ongoing bases 

to be adjusted during the remaining solvency period. 

German Pension Plans 

 Post-termination decrements and benefits. Disability, death, and retirement decrements 

can now be applied after termination for: 

o Active participants expected to terminate 

o Current terminated vested participants 

The associated post-termination benefits depend on service at termination and at second 

decrement (disability, death, or retirement), incorporating customizable legal vesting proration. 

 PSVaG liability. A new liability that incorporates PSVaG benefit caps is now available in 

Tax/Funding Valuations and Core Projections.  Necessary regulatory data for PSVaG Liability 

calculations is now built into ProVal, specifically the published Average Income level for former 

West and former East Germany. 

For more information, see Enhancements to German Pension Mode on page 14. 
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Netherlands Pension Plans 

 COLAs now apply to post-decrement death benefits with the beneficiary determined at member 

death.  (This was actually included as an update to version 3.02, but mentioned here in case 

you missed it.) 

 The “Post-Decrement Death Benefit” payment form now allows the beneficiary to be determined 

at the earlier of member death or a given member age (generally the member’s 

commencement age). This allows spouse benefits to be valued using a single payment form, 

rather than requiring both the joint life annuity payment form (for death after commencement) 

and post-decrement death benefit payment form (for death in deferral).  In addition, you can 

now explicitly specify that the spouse’s benefit commences immediately on member death and 

that coverage never ceases. 

Forecasting 

 End of Year Contribution Timing. In PPA Asset & Funding Policies when the additional 

contribution is based upon a funding liability measure, a date (m/d) can be specified for the 

timing of the contribution.  

 

 Some additional output variables have been added to the stochastic output dialogs, most 

notably employee contributions in U.S. Public, Universal, and Canadian pension modes, 

additional accounting information in all modes, and additional PPA output variables in U.S. 

Qualified Pension mode. 

Capital Market Simulations 

 Custom capital market simulators will now be populated with returns if switching to “Custom” 

within an executed simulation. This avoids having to export and import returns just to add a 

new asset class via import. Additionally, a custom simulation can now support yield curve 

stochastic forecasts as long as it started as an executed “Multi-Factor Term Structure” or 

“Explicit Corporate Yield Curve” simulation.  

Interface 

 Field name drop-down lists now let you type in the field name directly (previously, the best you 

could do was type the first letter repeatedly) as an alternative to picking it from the list.  You 
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can stop typing when you get to the field you want; ProVal autocompletes the field with the first 

match as you type. 

 

 When unhiding an object, ProVal now offers to unhide all referenced objects. For example, if 

you unhide a Valuation, ProVal will also offer to unhide the referenced Valuation Assumptions, 

Plan Definition, Benefit Definitions, etc. 

 

 The Project Library now utilizes the same interface found in other ProVal libraries.  Among other 

things, multiple projects can now be deleted at once.  

 

 A new “Clear settings” option in inverted libraries (e.g., output, descriptive statistics, frequency 

tables, etc.) lets you quickly “start over” to create a new output style. 
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 For Benefit Formula Components and Accrual Basis Components that vary by coded field, 

values for new codes can now be filled in without erasing prior results. 

 ProVal now offers to create a database field benefit component if a reference is made to a 

database field in a subformula (just as it already did in a Benefit Formula). 

 

 A new column in the Valuation Assumptions Library displays the type (F = funding, A= 

accounting). 

 

 A new column in the Custom Operators Library displays the type (SALARY, FAS, PIA, or CVCP). 

 The File > Options command now lets you to select a font to view entries on ProVal’s main 

screen (this command was previously found at File > System Maintenance > Options).  For 

example, you might increase the font size to make entry names easier to read (tip: first try 

adjusting font size by using Windows Control Panel, so that the change applies to all 

applications, not just to ProVal). Additionally, you might select another font. For example, if 

your entry names rely on alignment for easy readability, you might select a fixed width font 

such as “Courier New”, as displayed for these two (Valuation Assumptions library) entries: 

1/1/2009 NEW ASSUM NQ LS  

1/1/2009 OLD ASSUM Q  ANN 

 Throughout ProVal, “FAS 87/158” and “FAS 106/158” have been renamed “ASC 715”; “FAS 35” 

has been renamed “ASC 960”. 

 Keyboard shortcuts  

o Links in the Output Panes are now accessible using the Tab key.  

 

o The Compare button is now consistently accessed with Alt+M throughout ProVal. 

 All fields imported will automatically unhide after importing data. Previously, only new fields 

added to the data dictionary would unhide. Similarly, the fields PctMale, CAPctMale, and Count 

will automatically unhide after grouping data.   

 Client level notes can now be added in File > Properties. 
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 In the Payment Form library, the “Modified Cash Refund Annuity” dialog box now has a 

backdoor button to the Benefit Formula Component Library, so you can edit the component that 

defines the guaranteed amount on the fly. 

 In List Objects or input listings, the table of contents will now display only selected objects by 

default (previously, the default was to display all objects). 

Output & Reporting 

 In Valuation Output, projected benefit payments are now available by detail (e.g., by benefit, 

by pre/post-Medicare splits in OPEB mode, etc.). 

 In Core Projection Output, projected benefit payments are now available, allowing you to 

compare and add results across multiple runs. Previously, projected benefit payments were 

only available for a single Core Projection at a time via the View button. 
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Report Writer 

 When overrides are entered, a new right-click menu option lets you “Restore original value of 

x”.  

 

 OPEB data is now available by gross and cost sharing splits for inclusion in your reports.  

 

System 

 Batch log messages older than a specified number of days can now be deleted selectively 

(Batch Execution > View Prior Batch Messages) or automatically when packing files (File > 

Options, Pack). By default, messages older than 30 days will be deleted automatically in 

conjunction with file packing. These measures will help prevent the batch message log from 

growing without bound and contributing to hitting the 4GB limit (FILE FULL). 

Census Data 

 In Spreadsheet Edit, there is a new option on the View menu to “Clear Settings.” This restores 

all settings except zoom and transpose to their defaults (setting the view to all fields, all 

records, etc.). 

 For “Soc. Sec. #” type fields, ProVal now disallows non-integer values via import, manual entry, 

or Define Field by Expression. 

Experience Studies 

 A new option in the Databases & Census Specification topic lets you omit the list of RecIDs with 

data defaults from the output. 

Batch Server 

 The Batch Server’s status report now lists progress information (e.g., 75% complete) of any job 

currently running. 

Online Training 

 An online training course entitled “Introduction to Forecasting” has been added at 

www.winklevoss.com/webtrain.  Learn how to group data and enter assumptions to project 

liabilities. Then enter deterministic and stochastic assumptions to calculate future contribution 

and expense amounts. Online training courses are free, interactive, and can be completed at 

your own pace.  

ProVal PS 

 A “Prompt before updating files” command has been added to the Options menu. 

http://www.winklevoss.com/webtrain
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Two Greenwich Office Park 
Greenwich, CT  06831 
 
tel:   (203) 861-5530 
fax:  (203) 861-5531 

email:  support@winklevoss.com 
website:  www.winklevoss.com 

ProVal PS API 

 The ‘fsGetLiabsDims’ call has been extended to return sensitivity information. 

 A new ‘fsGetOUTX’ call returns detailed scenario results. 

For more information, see “ProVal PS API Users.doc” (distributed to ProVal PS API users only). 

Changes Log 

 Be sure to read the changes log (see the “Changes Log.Doc” file in the ProVal directory) about 

updates to certain calculations that may change results. 

 

WinTech’s Virtual 

Back Office 

Need help with a 

forecasting project?  

Why not call upon 

WinTech’s experienced 

actuaries to fill in?  

Contact Hank Freeman 

at (203) 861-5526 for 

details or to request a 

quote. 
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Multi-Core Computing 

ProVal version 3.03 includes a major performance enhancement.  Valuations, Core Projections and 

Gain/loss Analysis now run much faster on multi-core computers by simultaneously running 

calculations on up to four local processors.  In prior versions, ProVal would only use a single 

processor regardless of the number of processors available. 

How much faster will my runs be? 

Longer runs will show the most improvement.   Runs which currently take a short amount of time, 

such as less than two minutes, may not see any improvement (or be slightly slower).   

For these longer runs, the number of processors (P) is the primary factor that affects performance.  

You can estimate how much faster by using the equation 1 / (0.05 + 0.95 / P).  For example, a 

long run will be about 1.9x faster on a computer with 2 processors and about 3.5x faster with 4 

processors.  Note that if the processors are using Hyper-Threading (see discussion below), the 

number P should be decreased by dividing by 1.9. 

What do I need to do to take advantage of multi-core computing? 

Nothing.  ProVal will automatically distribute runs to up to four local processors.  The first thing you 

will notice is additional performance information on progress dialogs. 

  

ProVal will limit the number of processors to ensure a minimum of 700MB of memory is available to 

each processor.  If for some reason you would like to override the number of processors that 

ProVal distributes work to, add the MaxThreads parameter to the [Cloud] section in your 

PROVAL.INI file. 

[Cloud] 

MaxThreads=2 

You might want to reduce MaxThreads to ensure that other applications have sufficient CPU 

resources while ProVal is running in the background.  You might also choose to increase 

MaxThreads if you believe ProVal’s 700MB per processor default is too conservative for the 

complexities of your benefit plans.  A computer’s total memory will be split among the individual 

processors (note that 32 bit operating systems are limited to 4GB of memory, whereas 64 bit 

operating systems have a much higher limit). 
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How do I determine how many processors my computer has? 

An easy way to determine the number of processors on your computer is to view the Task 

Manager.  There are at least two ways to view the Task Manager: either press Ctrl-Alt-Delete and 

select Start Task Manager, or right click on the taskbar (runs across the bottom of your window) 

and select Start Task Manager.  Once the Task Manager is started, select the Performance tab.  

You should see a window similar to below.  The number of processors equals the number of mini-

graphs under CPU Usage History.  In the case below, there are 8 processors on the computer. 

 

 
 

Hyper-Threading 

An interesting and recent development with processors is a feature known as Hyper-Threading.  

Intel® Hyper-Threading Technology is a hardware feature supported in many Intel® architecture-

based server and client platforms that enables one processor to run two software threads 

simultaneously.  Basically, if the computer has installed Intel Hyper-Threading hardware, it will 

report to Windows twice the number of actual processors. 

 

In the case of the computer above, Windows believes there are eight processors but in reality there 

are four with Hyper-Threading. 

 

The relevance of Hyper-Threading to ProVal’s new multi-core enhancement is for estimating 

performance improvements.  Two Hyper-Threaded processors have a throughput of about 1.05 

processors (not 2).  Hence, when estimating the speed up using the equation above, the number of 

processors P should be decreased by dividing by 1.9 (1.9 = 2 / 1.05). 

For even more speed, can I harness processors on networked computers? 

Not yet.  We’re working on extending parallel processing to multiple computers using WinTech’s 

Grid Platform (expected early in 2012).  WinTech’s Grid Platform will allow ProVal runs to be 

distributed beyond the local machine to other computers on a network. 

 

We expect the equation above can still be used to estimate the increased speed with these 

additional processors.  For example, a run might be about 6x faster with 8 processors and 12x 

faster with 30 processors. 

 

The Grid Platform will be created by installing Grid Agents on any computer that is willing to 

participate.  The Grid Platform is designed with queuing logic which controls how frequently Grid 

Agents switch between competing runs so no one run is unduly penalized by heavy loads.  Also, 

the Grid Platform is designed with failovers among Grid Agents.  In the event a Grid Agent 

computer shuts down while running slices of a run, the stranded slices are placed back in the pool 

for other Grid Agents or the local computer to resume processing. 

 

WinTech’s Grid Platform is a separate product and will require additional licensing.  Contact your 

WinTech sales person for additional information.   
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Enhancements to German Pension Mode 

ProVal 3.03 includes many enhancements to German Pension mode in ProVal, including the 

following features: 

 Post-termination decrements and benefits. Disability, death, and retirement decrements 

can now be applied after termination for: 

o Active participants expected to terminate 

o Current terminated vested participants 

The associated post-termination benefits depend on service at termination and at second 

decrement (disability, death, or retirement), incorporating customizable legal vesting proration. 

 PSVaG liability. A new liability that incorporates PSVaG benefit caps is now available in 

Tax/Funding Valuations and Core Projections.  Necessary regulatory data for PSVaG Liability 

calculations is now built into ProVal, specifically the published Average Income level for former 

West and former East Germany. 

Active Participants with Post-Termination Benefits 

Valuation Assumptions 

Termination Rates can now be specified for Active Participants in Valuation Assumptions. 

(Previously, Termination Rates were forced to <no rates>.) 

Benefit Definitions 

Post-termination benefits utilize the same Benefit Definition specified for disability, death, and 

retirements from active service.  Although the same benefit formula is used for decrements from 

active service and post-termination decrements, the benefit amount differs.  Post-termination 

benefits incorporate legal vesting proration, as discussed in the Vesting section below. 

Sample Lives 

Liability reports (e.g. for PBO and ABO) now contain additional columns explicitly showing the 

probability of a prior Termination, and the Post-Termination Liability and Normal Cost in each case: 

 

Separate Post-Termination reports are also available to show the development of the “Liability at 

Termination” and “NC at Termination” values: 
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Terminated Vested Participants 

Census Specifications 

 

Census Specifications in German mode now contain a topic for Terminated Vested Data. Here, data 

is specified similar to Active participants. One data item that is unique to Terminated Vested 

Participants is the Benefit at Normal Retirement Date.  This is used in Benefit Formulas that 

reference the #NormToNRB operator (described below) to normalize estimated benefits to a known 

amount.  Note that this can be set to “<none>” if no corresponding data is available, or the 

specified database field can be left blank for the participants for whom information is unavailable.  
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Benefit Definitions 

 

Benefit Definitions can now be designated as applying to Active Participants, Terminated Vested 

Participants, or both. We expect that in many cases, Benefit Promises will apply the same benefits 

to Active and Terminated Vested Participants, but benefit programming can be separated if 

additional flexibility is required. For any Benefit Definition that applies to Terminated Vested 

Participants, the #NormToNRB operator is available. When used, it normalizes its right argument 

so that at Normal Retirement Date (as specified in the Benefit Promise) it equals the Benefit at 

Normal Retirement Date (as specified in the Census Specifications).  The same ratio is applied to 

other decrement ages, retaining the underlying accrual pattern. For further information, please see 

the article in ProVal Help entitled “#NormToNRB”.  

Vesting 

 

Accrual Definitions now contain a Vesting topic in German Pension mode, where you can specify 

vesting treatment for the component. When different components are combined within a single 

Benefit Formula, each Benefit Formula Component can use its own customized Vesting parameters 

for: 

 Whether service continues after termination (e.g. traditional defined benefit) or is frozen upon 

termination (e.g. contribution-related benefits) 
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 Whether a pro rata temporis fraction applies to the component after termination (e.g. 

traditional defined benefit) or not (e.g. contribution-related benefits) 

 Whether the component should be zero when not legally vested, or whether alternative 

contractual vesting applies 

Benefit Formulas with multiple layers (e.g. grandfathered benefits or minimums) can thus be 

programmed through a combination of Benefit Formula Components with various vesting options. 

Note that the option to “Apply default vesting” treats final average and basis only components with 

traditional defined benefit vesting parameters, and career average and cash balance components 

with contribution-related vesting parameters. For further information, please consult the article in 

ProVal Help entitled “Accrual Definition Vesting Topic”. 

 

Benefit Promises now contain parameters for legal vesting proration (i.e. the “pro rata temporis” 

factor that is applied after termination) that is applied to each underlying accrual definition for 

Retirement benefits: 

 Whether credited service is projected to the Normal Retirement Date, or to the Retirement 

decrement 

 Whether the pro rata temporis denominator is the vesting service at Normal Retirement Date, 

or at the Retirement decrement 

Note that when credited service is projected to the Normal Retirement Date, the denominator must 

also be the service at Normal Retirement Date. 

PSVaG Liability 

Methodology 

Valuation Assumptions now contain a topic titled “PSVaG Liability” which allows for the calculation 

of liability according to this method. For further details, please consult the Technical Reference in 

ProVal Help entitled “Teilwert and PSVaG Liability.” 

Regulatory Data 

Necessary regulatory data for PSVaG Liability calculations is now built into ProVal, specifically the 

published Average Income level for former West and former East Germany. Note that when PSVaG 

Liability is calculated, the old federal state for each participant must be specified in the Regulatory 

Data topic of Valuation Assumptions. For further information, consult the Command Reference in 

ProVal Help entitled “Regulatory Data.” 
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